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SAFETY

Caution/Warning
Disconnect the QuadTec’s power cable from its power source before servicing. Refer to 
Chapter 5, Maintenance, for instructions on servicing the BioLogic QuadTec system.

The BioLogic QuadTec UV/Vis detector is certified to meet the I.E.C. 1010-1* standard for safety of
laboratory equipment. Certified products are safe to use when operated in accordance with the instruction
manual. This safety certification does not extend to other chromatography equipment or accessories not
I.E.C. 1010 certified, even when connected to this QuadTec UV/Vis detector.

The QuadTec UV/Vis detector conforms to the class A standards for Electromagnetic Emissions, intended
for laboratory equipment applications. It is possible that emissions from this product may interfere with some
sensitive appliances when placed near or on the same circuit as those appliances. The user should be
aware of this potential and take appropriate measures to avoid interference.

This instrument should not be modified or altered in any way. Alteration of this instrument will void the
manufacturer’s warranty, void the I.E.C. 1010 certification, and create a potential safety hazard for the user.

Bio-Rad is not responsible for any injury or damage caused by the use of this instrument for purposes other
than for which it is intended, or by modifications of the instrument not performed by Bio-Rad or an authorized
agent.

*I.E.C. 1010 is an internationally accepted electrical safety standard for laboratory instruments.
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1.0  GENERAL DESCRIPTION

The BioLogic QuadTec multi-wavelength UV/Vis detector adds versatility to your biologic chromatography
system. The QuadTec detector has a wavelength range of 190–370 nm using the standard deuterium lamp
and 370–740 nm with the optional halogen lamp. The standard deuterium lamp is required for the detection
of peptides, proteins, DNA and other nucleotides.

Wavelengths are selected through the use of a moveable grating monochromator with an accuracy of ±1 nm
in 1 nm steps. The bandwidth is 8 nm or better. When using the deuterium lamp for the monitoring of
wavelengths >380 nm, an automatic cutoff filter is activated. This filter suppresses secondary grating orders
at wavelengths > 380 nm and thus ensures the selectivity of the measurement. Because very little light of
wavelengths greater than 400 nm is emitted from a deuterium lamp, the halogen lamp is required for routine
detection above 380 nm.

Figure 1-1. BioLogic QuadTec UV/Vis Detector

When connected to the BioLogic DuoFlow system via an Instrument Control Module (ICM), four wavelengths
may be monitored simultaneously and displayed on the Biologic DuoFlow Controller. In this configuration, the
QuadTec is controlled from the DuoFlow Controller.

When connected to the Biologic HR system via two Signal Import Modules (SIM-HR), two wavelengths may
be monitored and displayed simultaneously. In this configuration, wavelength selection and zero baseline
functions must be performed from the QuadTec UV/Vis Detector faceplate.

In stand-alone mode, two simultaneous wavelengths may be output to a chart recorder. The SCAN function
provides you with spectral information of a sample over the entire wavelength range and data may be output
to a chart recorder. This feature is NOT supported by the BioLogic system software.
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1.1  USING THIS MANUAL

The instructions provided in this manual are for use of the QuadTec Detector with the following systems:

• The BioLogic DuoFlow chromatography system

• The BioLogic HR chromatography system

• Stand-alone use

1.2  OPTICAL PATH OF THE QUADTEC UV/VIS MULTI-WAVELENGTH DETECTOR 

The light emitted from the lamp [1] is focussed by a lens [2] and a slit [4]. If a deuterium lamp is used and
wavelengths >380 nm are chosen, an automatic edge filter [3] is employed. The light passes to a grating
monochromator [6] for selection of the desired wavelength. The beam is then split by a semi-transparent
mirror [7]. Part of the beam passes to the photo diode reference signal [8] and optical absorption is
measured. The other part of the beam passes through the flowcell and sample and the light intensity is
measured at the sample photo diode [10]. The difference or the ratio of the two signals is calculated to
provide information about sample components.

Figure 1-2. Theory of Operations
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1.3  UNPACKING

When you receive the QuadTec detector and system accessory kit, carefully inspect the shipping containers
for any damage, which may have occurred in shipping. Severe damage to a container may indicate damage
to its contents. If you suspect damage to the contents, immediately file a claim with the carrier in accordance
with their instructions. If necessary, contact your local Bio-Rad office or Bio-Rad technical support at 
1-800-4-BIORAD.

• QuadTec Detector for Use with the BioLogic DuoFlow System

Includes a 3 mm PEEK flow cell, system cable 25 (RS232), 10-32 fingertight fittings (quantity 4).
See Figure 1-3. Also includes an instrument control module (ICM), system cable 26 (ICM power
cable), system cable 17 (BioLogic communication cable), DuoFlow software version 3.0, BioLogic
DuoFlow Instruction Manual chapter inserts, QuadTec instruction manual, power cord.

• BioLogic HR Accessory Kit for Use with the QuadTec Detector

Includes system cable 17 (BioLogic communication cable), SIM-HR (quantity 2), system cable 24
(QuadTec analog out cables to SIM-HR; quantity 2), QuadTec instruction manual, power cord.

• QuadTec Detector for Stand-Alone Use

Includes a 3 mm PEEK flow cell, system cable 25 (RS232), 10-32 fingertight fittings (quantity 4),
QuadTec instruction manual and power cord.

Figure 1-3. Package Contents of the QuadTec Detector

INTRODUCTIONSYSTEM OVERVIEW

1-3

Link

LoadProg

Hold 0Run 1
Time(min)

    1
(nm)

    2
(nm)

Edit ProgClear O Events:    2off 0      on / Signal 1[ au ]
Signal 2[ au ]

View

Setup

GLP

AUTO
ZERO

SCAN

1
2

3
4

56
7

8
9

0

3

0



1.4  PREPARING THE QUADTEC DETECTOR FOR OPERATION

1.4.1  Installation of the Flow Cell

The QuadTec detector is shipped with a “dummy” flow cell installed. Before operating the detector, you need
to install the biocompatible 3 mm PEEK flow cell. Refer to Figure 1-4 and the procedure below.

1. Make sure the detector power is OFF.

2. Loosen the two knurled screws on the front of the flow cell and gently pull them out. This allows the
flow cell housing to slide out.

3. Remove the dummy cell by gently pulling it upward. Save the dummy cell in a secure place. It is
required for measuring signal and reference output values for the lamps.

4. Insert the new flow cell and make sure that the engraved specifications point towards the user and
that the fixing hole on the back side of the cell meets the corresponding metal pin of the detector’s
housing.

5. Slide the complete system towards the detector, insert the two knurled screws, and tighten them by
hand.

6. Attach the 10-32 fingertight fittings and tubing to the inlet and outlet ports and use a syringe to rinse
the flow cell with 10–20 ml of 100% analytical grade methanol, followed by 5 ml DI water.

Figure 1-4. Installing the Flow Cell
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1.4.2  Power Up and Self-Test

The QuadTec detector is equipped with a universal power supply, which operates with supply voltages from
90 to 260 Volts AC. A manual setting of the supply voltage is not required.

Caution! Make sure to use a properly grounded power outlet and the power cable provided with the
system.

Before connecting the QuadTec to the Biologic DuoFlow or BioLogic HR system, perform the following
operation:

1. Connect the power cable to the QuadTec and the grounded power outlet, and then switch on the
device using the ON/OFF switch on the rear of the unit.

2. The display should show: Kernel v1.0, Bio-Rad BioLogic QuadTec UV-Vis 1.50.

Note: The firmware revision number may change.

3. Upon power-up, the QuadTec will run through a self-test which includes a check of the electronic
functions. Successful completion of self-test is indicated by SYSTEM TEST OK.

4. The QuadTec then runs through a wavelength calibration routine. A noise will be heard as the
monochromator moves. If the calibration is successful, the main menu will appear (see page 4-2
Figure 4-1).

If the detector calibration fails or takes an excessively long time, may be a sign that the lamp needs
replacing. See Chapter 6, Troubleshooting.

If the QuadTec self-test is successful, turn off the instrument, and then connect it to your chromatography
system using the instructions given on the following pages.
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2.0  USING THE QUADTEC WITH THE BIOLOGIC DUOFLOW SYSTEM

The QuadTec UV/Vis detector provides a powerful addition to the analytical capabilities of the BioLogic
DuoFlow system. An instrument communication module (ICM) provided with the detector permits complete
programming and control by the BioLogic DuoFlow software version 3.0 or greater.

When the QuadTec is attached to the BioLogic DuoFlow system via the ICM, up to four wavelengths can
simultaneously be monitored and displayed. The BioLogic DuoFlow displays a total of eight user selectable
traces including, four QuadTec wavelengths, conductivity, %B concentration based on method in use, pump
pressure, SIM pH, and SIM with any detector (fluorescence, refractive index).

Figure 2-1. QuadTec with the BioLogic DuoFlow System
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2.1  INSTRUMENT CONTROL MODULE (ICM): FOR USE WITH THE DUOFLOW ONLY

The ICM translates the signal from the QuadTec detector and transmits it to the BioLogic DuoFlow
workstation. The ICM contains the following:

Front View

• Address setting: The dial should always be set to position 1

• Instrument bus connector: This connector is for System Cable 17 which connects to the BioLogic
Workstation and the Model 2128 Fraction Collector if used. (Refer to Figure 2-3.)  

Rear View

• Serial Comm connector: This connector is for system cable 25 (QuadTec RS232 cable), which
connects to the QuadTec detector

• Power connector: This connector connects to the BioLogic DuoFlow workstation DC outlet with
system cable 26

Figure 2-2. Instrument Control Module (ICM) (front and rear views)
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2.2  ELECTRICAL CONNECTIONS TO THE DUOFLOW SYSTEM

The QuadTec communicates with the BioLogic DuoFlow system via the ICM module. To connect the
QuadTec to the DuoFlow system:

1. Use System Cable 25 to connect from the RS232 connector on the back of the QuadTec to the
COMM connector on the ICM module.

2. Use System Cable 26, the ICM power cord, to connect to the back of the workstation.

3. Use System Cable 17 to connect between an instrument bus connector on the ICM and an available
instrument bus connector on the workstation.

4. If you are using a Bio-Rad device with an instrument bus connector, such as the Model 2128 fraction
collector, use another system cable 17 to connect between the instrument bus connectors on the
Model 2128 and the ICM.

Figure 2-3. Connecting to the DuoFlow System
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2.3  PLUMBING CONNECTIONS TO THE DUOFLOW SYSTEM

The QuadTec has a PEEK flow cell that must be installed by the user. The detector fittings which have been
provided are standard HPLC 10-32 fingertight fittings. The BioLogic system uses 1/4-28 fittings.

To plumb the QuadTec to the BioLogic DuoFlow system:

• Plumb the detector after the column and before the conductivity monitor with the orange or green
PEEK tubing provided with the DuoFlow. The tubing length between the column and the detector
should be as short as possible.

• The flow is from the left to the right side of the instrument as shown in the picture below.

Figure 2-4. Plumbing to the DuoFlow System
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2.4  SYSTEM POWER UP

To power up the QuadTec Detector with the BioLogic DuoFlow system:

1. Important: Ensure that the BioLogic DuoFlow software application is not running.

2. Turn on power to the DuoFlow workstation. The ICM power LED should light, since it receives power
from the workstation. If it doesn’t, ensure that the ICM power cable is connected to the workstation.

3. Power up the QuadTec using the power switch on the rear of the detector.
The QuadTec detector goes through a startup routine, self-test and lamp calibration routine.

4. If these routines are successful, the bottom left of the QuadTec screen will display ON. At this point,
the BioLogic DuoFlow software application may be launched.

5. When the DuoFlow Controller establishes communication with the QuadTec detector, the top left of
the QuadTec detector screen will show SLAVE. The BioLogic Controller will show a QuadTec
detector faceplate in the Manual screen. The system is then ready for operation.

2.5  SYSTEM OPERATION

When the QuadTec is connected to the BioLogic DuoFlow system, it is automatically recognized and its
functions are controlled from the Manual Control screen and the Run screen. These are discussed below.

2.5.1  Manual Screen

In the Manual screen (Figure 2-5), the QuadTec appears in its own control panel; the QuadTec controls are
listed below. The QuadTec Detector control panel can be toggled to the BioLogic standard UV monitor
control panel.

• Mode: To control the QuadTec from the DuoFlow system, select System mode. To control the
QuadTec from its front panel, select Local mode.

• Zero baseline: Resets the detector AU value to zero.

• On/Off: Turns the lamp on and off.

• Lamp: Indicates whether the lamp is Deuterium or Halogen.

• Range: Displays the wavelength range for the lamp in use. The range for Deuterium is 190–370 nm;
that for Halogen is 370–740 nm.

• Wavelength selection: Use the checkbox and up/down arrows to select each wavelength.
Note: Wavelengths selected in the Manual screen will not be automatically selected in the Method
Protocol Editor screen.

• Set: Implements the wavelength setting.
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Figure 2-5. Manual Control Screen, Showing the QuadTec Detector
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The traces shown on the Manual screen chromatogram and printed report are chosen in the Chromatogram
Settings window, shown in Figure 2-6. From the system toolbar, select the Settings button to display the
Manual screen Chromatogram Settings window. Select the traces from the Trace Device drop-down menu.
Select up to eight traces. Select the Visible checkbox to indicate whether or not the trace is to be visible on
the screen.

Figure 2-6. Manual Screen Chromatogram Settings

To set the QuadTec detector’s Time Constant, select Manual Setup from the Options drop-down menu. In
the Manual Setup screen, shown below, enter the QuadTec Time Constant. The Time Constant value
smooths the signal with a time filter. The default value of 1.0 seconds is suitable for most applications.

Figure 2-7. Manual Setup Screen
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2.5.2 Setup Editor Screen

The Setup screen selects devices to be included in a method. BioLogic DuoFlow software versions 3.0 and
later includes the QuadTec Detector. Use the Detectors button in the Setup screen to display the Edit
Detector window. Select the QuadTec button and enter the desired wavelengths for your method. The Time
Constant value smooths the signal with a time filter. For most routine applications, a Time Constant value of
1.0 seconds is recommended.

Figure 2-8. Edit Detector Window

2.5.3  Run Screen and Chromatogram Settings

The Run screen, shown in Figure 2-10, reflects the real-time sample run. The traces shown on the Run
screen are chosen in the Chromatogram Settings window. From the system toolbar, select the Settings
button to display the Run Screen Chromatogram Settings, shown in Figure 2-9. Select the traces displayed,
depending on the instruments being used, select up to eight traces from the following: Conductivity, standard
optics module UV, GP-pressure, four QuadTec traces, two SIM traces, or two pH trace, by the Trace Device
drop-down menu in this window. Select the Visible checkbox to indicate whether or not the trace is to be
visible on the screen.

Figure 2-9. Run Screen Chromatogram Settings
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Figure 2-10. Run Screen, Showing Chromatogram for QuadTec Detector

The Run screen provides:

• Wavelength status: The wavelengths in use by the QuadTec. The AU output for each wavelength
also is shown.

• QuadTec zero baseline button: Resets the detector AU value to zero. Note: Use care when using
this feature during a collection scheme which uses a Threshold value.

• Chromatogram traces: Each trace can be individually scaled. Use the boxes on each side of the
chromatogram to select a trace. Use the Up/Down scrolling bars on each side of the chromatogram
to scale the trace.
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3.0  USING THE QUADTEC WITH THE BIOLOGIC HR SYSTEM

The QuadTec UV/Vis detector provides a powerful addition to the analytical capabilities of the BioLogic HR
system. The QuadTec can simultaneously monitor two different wavelengths when connected to the BioLogic
HR via two SIM-HR modules.

Figure 3-1. QuadTec with the BioLogic HR System
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3.1  ELECTRICAL CONNECTIONS TO THE BIOLOGIC HR SYSTEM

Set up the BioLogic HR system with the QuadTec detector on the bottom tray. Do not turn power on.

1. Connect one SIM-HR to the HR Workstation with System Cable 17, and ensure that the SIM’s
device address number (Device Number) is set to 1.

2. "Daisy-chain" a second SIM-HR to the first SIM-HR using a second System Cable 17. The device
address number (Device Number) of this second SIM-HR must be set to 0.

3. Connect the QuadTec to the SIM-HR modules using two System Cable 24, an analog cable that has
red and black bare wires at one end and a gold colored banana plug at the other. Plug the banana
plugs into the 1V Integrator sockets on the rear of the QuadTec marked 1 and 2. The cable in socket
1 should go to the first SIM-HR (Device Number 1) and the cable in socket 2 goes to the second
SIM-HR (Device Number 0). In both cases the cable red wire goes to the analog + connector and
the black wire to the analog - connector of the SIM-HR.

4. If a Model 2128 Fraction Collector is to be used, connect it to SIM 2 using System Cable 17.

Figure 3-2. Connections to the BioLogic HR System
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3.2  PLUMBING CONNECTIONS TO THE BIOLOGIC HR SYSTEM

After making all the cable connections make the plumbing connections, as shown in Figure 3-3.

Figure 3-3. Plumbing to the BioLogic HR System

3.3  SYSTEM OPERATION WITH THE BIOLOGIC HR

Each time the QuadTec is powered on, it runs a self test. If successful, the lamp warms up to a constant
working temperature. During warm up, the display shows HEA in the lower left position. The initialization
routine is completed by an automatic calibration procedure, and the device is ready for operation when ON
is shown in the lower left position.

3.3.1 Using the QuadTec Faceplate Keys

The following QuadTec front panel keys and displays are used:

• Arrow keys: The green, arrow-shaped keys are used for moving and positioning the cursor in the
display and for confirming an entered value.

• Numeric keys: The blue, numeric keys 1 to 0 are used for entering numeric values at the position
of the cursor.

• Auto zero: When pressed for less than 2 seconds, this key performs an auto-zero over the whole
wavelength range. This feature is required for use with the BioLogic HR system and in stand-alone
mode. With the BioLogic DuoFlow, zero baseline commands are sent from the Controller.
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3.3.2  Changing Operating Parameters

To change any parameter value:

1. Use the green arrow keys to move the blinking cursor to the desired position on the display.

2. Press the numeric keys to enter or change values.

Important: Confirm and leave this position by pressing any arrow key.

Input is disabled automatically if a time limit of 60 seconds is reached without pressing any key, and the
screen returns to the main menu.

If the screen display does not change in response to a key press, momentarily hold down the key.

3.4  SELECTING WAVELENGTHS AT THE QUADTEC

Use the green left arrow key to select the View menu.

1. Position the cursor on one of the two wavelength fields and select the wavelength by entering the
desired values with the numeric keys. If you want to use one single wavelength, enter a zero in the
unused fields. Entering zero deactivates the respective wavelength.

2. If you select two wavelengths, the QuadTec monitors absorbance at each wavelength, sampling
each wavelength 5 times per second. You will hear the high frequency sound of the motor when
using two wavelengths.

3. A cutoff filter for suppressing secondary grating orders is activated automatically if one or both
wavelength(s) exceed 381 nm and a deuterium lamp is installed. The use of the filter is displayed by
a superscripted +.

3.5  CONFIGURING THE BIOLOGIC HR SOFTWARE

Configuring the BioLogic HR software is done from the Manual setup screen, shown in Figure 3-4.

Figure 3-4. Manual Setup Screen

To configure the BioLogic HR software:

1. From the Options drop-down menu in the BioLogic HR software Manual Screen, select Manual
Setup.
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2. Configure SIM 1 and 2 “Units” value for the desired wavelengths (e.g., AU 280 nm and AU 260 nm.)
Unit Range, Minimum = 0
Unit Range, Maximum = 2
Device Output Range (Volts), Minimum = 0
Device Output Range (Volts), Maximum = 1

3. The Device Output Voltage maximum should be set to 1 V, which is the output from the QuadTec
Detector integrator outputs.

4. From the Options drop-down menu in the Manual Screen, select Chromatogram Settings. From the
Trace Device drop-down box, select SIM 1 and 2 /Signals and click on the Visible box.

5. From the Manual screen, choose the detector signals you wish to see from the drop-down menus
and scale using the scroll bars. Note that the QuadTec detector must be zeroed from the faceplate of
the detector itself.

6. Note that on the status bar, SIM-HR signals will appear as voltage readouts.

3.6  WRITING A METHOD

1. After selecting “New Method” from the manual screen and naming the method, the Setup Editor will
appear. After placing the SIM-HR devices in “Devices in Setup”, you must enter the relevant
QuadTec information (double-click to open the SIM-HR dialog boxes to do this).

2. The information in Devices in Setup should be identical to that already entered in Manual Setup but
it is not automatically transferred to each Setup Editor.

3. If the Setup conditions are expected to be constant from Method to Method, use the “Save Setup as
Default” command under the File menu.

4. Repeat for SIM-HR #2.

5. A maximum of four traces may be displayed at present. For example, SIM-HR #1, SIM-HR #2, and
conductivity. In addition, the theoretical gradient (%B) is always shown.

6. Select the Protocol icon from the Setup screen and enter the desired method parameters. Select
Run and Start to run a sample.

7. The Run screen and Post-Run screen may be customized as required by clicking on the Options
menu and selecting “Chromatogram settings”.

Detailed information about programming your BioLogic HR can be located in its Instruction Manual.

3.7  QUADTEC DETECTOR SETUP MENU

In the QuadTec Setup menu, parameters for the operation of the QuadTec UV/Vis detector can be adjusted.
These parameters comprise values for operation of the instrument. To access the Setup menu, position the
cursor at the top right of the display and press and hold the green right arrow key. The cursor will blink over
the rhombus in the lower left corner. To move between Setup parameters, use the green Up/Down arrow
keys.

TIME CONSTANT For smoothing the signal with a time filter. The value can be chosen between 0.1,
0.2, 0.5, 1, 2, 5, and 10 seconds. The bigger the value for the time constant, the
more the signal is smoothed. Press the green Right arrow to position the cursor and
then use the green Up/Down arrows to toggle between the available values. For
most applications using the BioLogic HR and DuoFlow systems, a time constant of
1 s is recommended.
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AUTO CALIBRATION From Time Constant, press the green Right arrow to move to this field. Pressing the
green Up arrow starts the procedure for the calibration of the wavelength scale. It
searches automatically for reference points within the spectra of the lamp for
reliability and reproducibility of the wavelength. The points used for calibration are
the zero order reflection of the grating (000 nm) and the Ha spectral line of
Deuterium (656 nm). Auto calibration is performed automatically when power to the
detector is switched on.

LAMP The lamp type is specified using the Up arrow to toggle between Deuterium and
Halogen. Changing the lamp type prompts a question on whether to reset the lamp’s
working time. Pressing any green arrow key will reset the time. The lamp number is
incremented automatically and cannot be edited.

(Note: See the instructions on page 5-4 for configuring the appropriate wavelength
settings in the Setup menu after a lamp change.)

When replacing a deuterium lamp, the working time should be reset as this value is
used in the GLP report. Position the cursor on the working time value and press the
Up arrow. Pressing the Up arrow again resets the working time to zero and
increments the lamp number.

The ON/OFF field enables you to switch off the lamp without switching off the
instrument.

SIGNAL For use with the BioLogic HR, set this option to Absorption.

The values “sig” and “ref” give the measured light intensity on the signal and the
reference diode respectively. The sig and ref values range between 0 and 1. Their
absolute values are dependent on the wavelength, the solvent, the flow cell used
and the age of the lamp.

With the dummy flow cell in place and a wavelength selection of 240 nm, the value
of ref should be between 0.1 and 0.9. A value of <0.2 indicates that the deuterium
lamp should be replaced, especially if noise and sensitivity are unacceptable.

SCAN OUT Not available with the BioLogic HR system.

ANALOG OUT Absorbance signals to the SIM-HRs for display on the BioLogic HR system come 
FULL SCALE from the two integrator outputs on the rear of the detector and may be scaled.

Full scale may be set from 0.0001 to 10 AU (in 16 steps) using the Up and Down
arrow keys.

The maximum output voltage may be set to 0.1, 1, and 10 V.

For the BioLogic HR system, set the values to 2 AU and 1 V.

ANALOG OUT Not used with the BioLogic HR system.
OFFSET

ANALOG IN Not used with the BioLogic HR system.

CONTROL Not used with the BioLogic HR system.

DATE/TIME The date and time are set here.

FRACTION Not used with the BioLogic HR system.
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4.0  STAND-ALONE MODE

Turn on power to the QuadTec detector and wait while it completes its self test. If successful, the lamp will
warm to a constant working temperature. During warm up, the display shows HEA in the lower left position.
The initialization routine is completed by an automatic calibration procedure, and the device is ready for
operation when ON is shown in the lower left position.

4.1  SYSTEM OPERATION IN STAND-ALONE MODE

4.1.1  Using the QuadTec Faceplate Keys 

To change any operating parameter, use the following:

• Arrow keys: The green, arrow-shaped keys are used for moving and positioning the cursor in the
display and for confirming an entered value.

• Numeric keys: The blue, numeric keys 1 to 0 are used for entering numeric values at the position
of the cursor.

• Auto zero key: When pressed for less than 2 seconds, this key performs an auto-zero over the
whole wavelength range. Pressing longer than two seconds starts a scan auto zero.

• Scan key: The yellow colored SCAN key switches to the SCAN menu. After switching to this menu,
pressing the SCAN button again triggers a scan over the chosen wavelength range.

4.1.2  Changing Operating Parameters

To change any operating parameter value (e.g., wavelength):

1. Using the green arrow keys, move the blinking cursor to the desired position on the display.

2. Use the numeric keys to enter or change values.

3. Once the desired value has been entered, press any arrow key to confirm.

Input is disabled automatically if a time limit of 60 seconds is reached without pressing any key, and the
main menu is displayed.

Note: If the screen display does not change in response to a key press, repeat press and momentarily hold
the key.

4.1.3  Accessing Menus

Using the arrow keys on the keypad, the blinking cursor can be moved to any position on the menu. If the
cursor has reached an exterior position in the menu (e.g., ON in the lower left corner of the main menu),
pressing and momentarily holding the green arrow key will display the VIEW MENU.

Menus consisting of several pages are indicated by a rhombus (◆) in the lower left corner of the display. To
access these pages, place the cursor on this rhombus and press the green Up/Down arrow keys.

In certain menus, the keys 0, 1, and 2 are used to HOLD (0) a defined program, or to RUN (1), or to
INSERT (2) event steps, e.g. to program the event pulse.
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4.2  DISPLAY AND MENU STRUCTURE

After the QuadTec has been switched on and the self-test routine has been successfully run, the device is
ready for operation and the main menu or operation screen will be displayed.

Figure 4-1. Stand-Alone Operations Screen

4.2.1  The QuadTec Detector Setup Menu

In the Setup menu, parameters for the operation of the QuadTec UV/Vis detector can be adjusted. To access
the Setup menu, position the cursor at the top right of the display, and press and hold the green right arrow
key. The cursor will blink over the rhombus (◆) in the lower left corner. To move between Setup parameters,
use the green Up/Down arrow keys.

Figure 4-2. Overview of the Setup Menu

TIME CONSTANT For smoothing the signal with a time filter. The value can be chosen between 0.1,
0.2, 0.5, 1, 2, 5, and 10 seconds. The bigger the value for the time constant, the
more the signal is smoothed. For most applications, a Time Constant of 1 s is
recommended. To change this value, press the Right arrow key to position the
cursor and then use the Up/Down arrow keys to toggle between values.
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AUTO CALIBRATION This procedure searches automatically for reference points within the spectra of the
lamp for reliability and reproducibility of the wavelength. The points used for
calibration are the zero order reflection of the grating (000 nm) and the Ha spectral
line of deuterium (656 nm). Auto calibration is performed automatically when power
to the detector is switched on. To access auto calibration, from the Time Constant
parameter press the Right arrow key to move to this field. Pressing the Up arrow key
starts the procedure for calibration of the wavelength scale.

LAMP The lamp type is specified using the Up arrow to toggle between deuterium and
halogen. Changing the lamp type prompts a question on whether to reset the lamp’s
working time. Pressing any green arrow key will reset the time. The lamp number is
incremented automatically and cannot be edited.

Note: See the instructions on page 5-4 for configuring the appropriate wavelength
settings in the Setup menu after a lamp change.

When replacing a deuterium lamp, the working time should be reset, as this value is
used in the GLP report. Position the cursor on the working time value and press the
Up arrow. Pressing the Up arrow again resets the working time to zero and
increments the lamp number.

The ON/OFF field enables you to switch off the lamp without switching off the
instrument.

Figure 4-3. Lamp Specification Menu

SIGNAL You can select the signal source used for all data outputs using the Up/Down arrow
keys to toggle between the following: Absorption, Signal, and Reference channels.

The values “sig” and “ref” give the measured light intensity on the signal and the
reference diode respectively. The sig and ref values range between 0 and 1. Their
absolute values are dependent on the wavelength, solvent, flow cell used, and age
of the lamp.

With the dummy flow cell in place and a wavelength selection of 240 nm, the value
of reference should be between 0.1 and 0.9. A value of <0.2 indicates that the
deuterium lamp should be replaced, especially if noise and sensitivity are
unacceptable.

SCAN OUT The output speed of scan data via the integrator output. Available values are 1, 2, 5,
10, 20, and 50 steps per second (approximately. 1–50 nm/second).
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ANALOG OUT Absorbance signals come from the two integrator outputs on the rear of the detector 
FULL SCALE and may be scaled.

Full scale may be set from 0.0001 to 10 AU (in 16 steps) using the Up/Down arrow
keys.

The maximum output voltage may be set to 0.1, 1, and 10 V.

Figure 4-4. Menu for Scaling Analog Outputs

ANALOG OUT The output voltage of the outputs is set to zero during the detector self test. In this 
OFFSETS window, a numerical value for an offset in mV units that will be added to the

corresponding signals on the analog outputs may be set. This function can be useful
when using a chart recorder to separate the traces from the two channels.

ANALOG IN For calibrating the analog input for external wavelength control.

Activating Set-Zero by pressing the Up/Down arrows in this field defines the actual
input voltage as zero, wavelength 000 nm. An external signal, e.g. 5.0 V is then
applied. The “actual_” field shows the interpreted wavelength, which should be 500
nm using the preset conditions of 100 nm = 1 V. This wavelength value can then be
modified with the Up/Down arrow keys, which creates a second calibration point.

CONTROL The detector can be set to different external control modes. You can choose
between KNAUER-NET, where the baud rate is currently limited to 9600, RS-232,
RS-485 and ANALOG. When choosing the analog option, only one wavelength can
be used and controlled by the analog input voltage. The operation screen is modified
correspondingly.

The options RS-232 and RS-485 enable the use of a RS-232 or a RS-485 protocol
for controlling the instrument with a terminal program.

Knauer-Net is not currently supported by Bio-Rad.

DATE/TIME The system date and time is set here in European format (day-month-year).

FRACTION The Event outputs of the detector may be set to control a fraction collector using
either Relay [E1], or TTL [E2] signals. The corresponding output on the rear of the
detector should be connected to the fraction collector.

Enter a delay time in seconds in the first line (delay = time taken for liquid to go from
the detector to the fraction collector drop head).

Figure 4-5. Fraction Collector Setup Menu
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Use the Right arrow key to access the output field and select E1 or E2 as
appropriate.

Use the right arrow key to access the signal level. Set the minimum signal level that
must be exceeded before fraction collection starts.

Both functions, level and event, are evaluated in a timetable to control fraction
collection. This means, that the E1 or E2 output is activated only when the level is
exceeded and during a time window in the timetable of a method. In case of missing
time programs, the appropriate event has to be set to “1” in the operation screen.

If fraction collection is controlled by the signal level only, the event output becomes
active every time the signal exceeds the preset signal level.

4.2.2  LINK Menu

The Link menu is used when running links, which are a pre-defined run of program combinations. In this
menu the momentary status of the program links can be monitored.

In the first line of the menu the momentary status can be observed, and the number of runs (R-xx) to be
performed counts downwards. In the second line the next step of the link to be executed is shown. Arrows at
the right side of the display indicate that more program lines above and below, respectively, do exist.

Figure 4-6. Overview of the Link Menu
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4.2.3  VIEW Menu 

The View menu gives an overview of existing programs and program links. The following figure shows an
example where programs 01, 02, 03, 04, and 11 and link 21 have been defined.

Figure 4-7. Overview of the View Menu

4.3  STAND-ALONE CONTROL OF THE QUADTEC UV/VIS DETECTOR

When using the QuadTec detector, note the following:

• Direct control of the QuadTec UV/Vis detector is performed via the Main Menu/Operation screen,
e.g. selection of wavelength(s).

• Programs can be used for determining and changing wavelengths or setting signal events during
runs. The QuadTec UV/Vis detector features storage and selection between up to 20 different
programs with a maximum number of 100 program lines for each program. Nine different links can
be stored for calling programs within programs.

• A useful feature of the QuadTec UV/Vis detector is its ability to scan UV-spectra with a speed of
approximately. 100 nm/s on flow. Scans are handled in the SCAN menu, which is accessed simply
by pressing the SCAN button.

After power on, the instrument starts automatically with the last used program. If no programs had been
loaded, the standard program is defined to be No. 01.

Figure 4-8. Standard Operation Screen with Cutoff Filter Activated
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4.3.1  Selecting Wavelength(s)

Use the green Left arrow to select the View menu and then:

1. Position the cursor on one of the two wavelength fields and select the wavelength by entering the
desired values with the numeric keys. If you want to use one single wavelength, enter a zero in the
unused fields. Entering zero deactivates the respective wavelength.

2. If you use both wavelengths, the grating monochromator moves between the positions
corresponding to the selected wavelengths. This movement is performed with a frequency of 10 Hz
that cannot be changed. You can hear the motor of the monochromator as a high frequency tone.

3. A cutoff filter for suppressing secondary grating orders is activated automatically if one or both
wavelength(s) exceed 381 nm and a deuterium lamp is installed. The use of the filter is displayed by
a superscripted +.

4.3.2  Output Options 

The output of absorption signals can be configured. Move the cursor to the signal fields and choose between
the different options by pressing any numeric key. The following options are available:

• Signal inversion (indicated by a superimposed minus sign).

• Two different ratio plots are available:

• Wavelength (1) divided by wavelength (2) 

• Wavelength (2) divided by wavelength (1)

Ratio plots are indicated by symbol 1/2 and respectively 2/1 at the decimal point of the absorption value.

Figure 4-9. Inversion of Signal and Ratio Plots: Set/Indicated Output Options

Ratio plots contain information on peak purity by dividing the intensity values at two different wavelengths. It
is possible to measure the absorption at one wavelength and to monitor simultaneously the ratio of
absorption between this wavelength and another one. Ratio plots can be accessed at the analog out
connector to a chart recorder.

The scaling of the analog outputs can be adjusted to different values of absorption units or to different
voltage values. For details see “Analog Out Full Scale” on page 4-4: in the section “Setup Menu”.

4.3.3  Events 

The EVENTS outputs on the rear of the detector provide time programmed signals to other instruments. This
is described in section 4.8, “Connecting Other Instruments to QuadTec Detector.” When working without a
time program, using Events enables fraction collection (see “Fraction” on page 4-4).
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4.4  PROGRAMMING THE QUADTEC UV/Vis DETECTOR

4.4.1  Creating Programs

When creating programs, note the following:

• The QuadTec can store up to 20 programs. By moving the cursor to the VIEW menu, you can check
the availability and allocation of program numbers.

• All programs are saved permanently until overwritten.

• Time displays are given in minutes with decimal calculation of seconds, i. e. 0.3 min = 18 s. Time
resolution during input is 1/10 min, during program runs 1/100 min.

• Wavelengths and events can be changed as a function of time. Set up parameters such as scaling
of the analog outputs cannot be time programmed. All options for analog outputs like ratio plots can
be defined for entire programs and will be used when loading the program.

• Use the EDIT mode for modifying or creating programs. Move the cursor to the “Edit Prog” field and
enter the desired program number with numeric keys. Any numeric values can be overwritten.
Pressing any arrow key confirms the actual value.

• The first line of a program is the start time at 0 min. This time cannot be changed. The message
“Start time is fixed” appears on attempting to edit this line. The maximum value for time is 999 min.

• To edit a new time line, move the cursor to the time field and press the Down arrow. If this line is
empty, in the time field will be displayed ***.*.

Figure 4-10. Empty Time Line In Program No. 3

4.4.2  Deleting Programs

You can delete a program line if you enter 0 in the field time and press any arrow key. The message “Delete
this line? Confirm by cursor” will be displayed. You can confirm deletion if you press any arrow key. If you
press a numeric key, or wait for 60 seconds, deletion will be aborted.

Values 0, 1 and 2 can be used for programming of events. (See section 4.8, “Connecting Other Instruments
to QuadTec Detector.”)
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4.4.3  Time Programming of Absorption Wavelengths

Use this instruction for programming the absorption wavelengths as a function of time.

1. Access the Operation/Main menu screen.

2. Move cursor to the field “Edit Prog” and select a number (1 to 20) for the new program.

3. Press any arrow key to confirm and enter Edit mode for the new program.

4. The cursor is automatically moved to Time 000.0, which is the fixed start time.

5. Press the Right arrow key to go to field 1. Enter the desired wavelength (e.g. 220 nm).

6. Move cursor to field 2 and enter your second desired wavelength (e.g. 254 nm).

7. Press the Down arrow key to create the next step of the program. The blinking cursor will be on the
first asterisk of the time field.

8. Press 1 and 0 and then the Right arrow key to define the time step as 10.0 min. Enter field 1 and put
in 240 nm and complete entering by pressing the Down arrow key. The value for 2 (254 nm) is kept
constant as long as no changes are made.

9. Repeat the last two steps, define time step 20.0 min and enter 280 nm.

Figure 4-11. Four Steps for Creating a Program
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4.4.4  Programming Events for Control of a Fraction Collector

This example demonstrates a program to control a fraction collector via the QuadTec UV/Vis detector event
output using signal level and a defined time window.

1. Enter the Setup menu and proceed to the window Fraction.

2. Enter the desired value for the signal level, e.g. 0.32 AU, the delay volume if needed, and select E1
for relay output.

3. Return to the operation screen

4. Move cursor to field “Edit Prog” and select a number (1 to 20) for the new program.

5. Press any arrow key to confirm and enter Edit mode for the new program.

6. To set the Time Window for collection. At the Time field 0 min, the Events field should be 00. Use the
Down arrow to change the Time to 5.00 and program the Events field to 1 0. Use the Down arrow to
change the Time field to 10.00 and the Event field to 0 0.

7. Event 1 (relay output) will be enabled from 5 to 10 minutes. Any peaks within the Time Window
exceeding the signal level (0.32 au in this example) defined in the SETUP menu leads to generation
of an event at the signal outputs.

8. Peaks exceeding the signal level between 0 and 5 minutes will not produce an event signal.

9. The value for level chosen in the SETUP menu, will always apply for all programs, it cannot be set
individually for single programs.

Figure 4-12. Programming Events
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4.4.5  Program Execution

Programs must be activated prior to execution. To execute a program:

1. Enter the desired program number in the “Load Prog” field and confirm by pressing an arrow key.
The detector settings are adjusted to all presets of that program.

2. An autozero is performed automatically every time a new program is loaded.

3. The time table of the program is started by moving the cursor to the ON field in the lower left corner
of the display. Pressing 1 then starts the program. The display switches to RUN, and the elapsed
time is displayed in the field Time.

4. Pressing 0 will interrupt program execution. It is stopped with the actual values, indicated by a
blinking time line. The message HOLD is displayed.

5. The program can either be continued by pressing 1 and returning to RUN again or it can be stopped
by pressing 0 again. If you stop program execution the instrument will return to the parameters of the
start time. These initial parameters are activated also after a program run is finished.

6. A program can also be started via the START IN input on the rear of the detector. When a trigger
signal is applied to this input, the detector switches into RUN mode.

4.4.6  Program Links

To create program links, note the following:

• Program links are cross-references to existing programs, which can be defined and edited similar to
programs themselves. Links cannot reference other links.

• In the editing mode, Links are defined and loaded as the reserved program numbers 21 to 29,
where program 21= L1, 22 = L2, etc.

• Links have line numbers from Number 01 up to Number 99, every line containing one program, one
number for repetitions and a wait-status programmable.

• The QuadTec Detector can store up to 9 different links, but the maximum number of programs used
in all links is limited to 100. Each program may appear in any frequency in any link.

To program a link:

1. Enter the number of the desired link in the “Edit Prog” field, e.g. 22 for link L2 , 23 for L3, etc. Press
any arrow key to confirm.

2. A new screen will appear with the cursor blinking at No**. Press any numeric key to generate a new,
continuously numbered line. In this case No 01 will appear.

3. Use the Right arrow to move the cursor to P-field (Program) and choose the desired program
number, e.g. 03.

4. Press the Right arrow again to access the R-field (Repeat) where the number of runs to be
performed with the selected program, e.g. 05, can be entered.

5. In the Wait field, the values 1 or 0 can be entered. For Wait = 1, the detector will wait for an external
start signal or for an operator pressing 1 on the RUN field.

6. If Wait = 0, the program lines of the link are carried out continuously without any pauses.

To run a program link, start by loading it and then:

1. Enter the desired link number in the Load Prog-field, e.g. 22 for L2, 23 for L3. Confirm by pressing
any arrow key.

2. During the execution of a link, the LINK menu is available in addition to the Operation/Main menu
display.
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3. In the LINK menu, the momentary status of the running link is shown. To access this menu move the
cursor to the “Load Prog” field and press the Left arrow.

4. To return from the LINK menu press the Right arrow.

To delete a program or a link, it has to be loaded first and then:

1. Entering 0 in the Edit Prog and pressing an arrow key will produce the message “Delete this
program? Confirm by cursor”. Pressing any arrow key will delete the loaded program or link.

2. Pressing a numeric key or just waiting for 60 seconds without pressing any key will abort the
deletion process.

Figure 4-13. Programming Links

4.5  SCANNING UV-SPECTRA

4.5.1  Scan Menu

Pressing the yellow Scan button accesses the Scan menu. This menu is used for selecting the number
under which to save the scan data, choosing the wavelength range for the scan and for output of the stored
scan data.

Figure 4-14. Scan Menu

The QuadTec detector can store up to four different scans in the internal memory. The four scans are
numbered from 1 to 4. Each scan is saved by the QuadTec detector and can be accessed and given out via
the analog outputs to a chart recorder.
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The number of the scan to be performed or given out is selected by moving the cursor to the scan number,
(e.g. no.:1 with the Right arrow.) The scan number can be changed using the Up/Down arrows. The
wavelength ranges for all scans can be varied between three options:

190 to 380 nm

381 to 740 nm

190 to 740 nm

The wavelength range is selected by moving the cursor with the Right arrow to the corresponding field and
by choosing the appropriate wavelength range by toggling the Up/Down arrows. The selected range applies
always for all four scan numbers.

Caution: If the wavelength range is changed, spectral data in the memory of the QuadTec detector are
erased.

4.5.2  Scan Autozero 

Before scanning spectra, the QuadTec detector must perform a scan autozero. The scan autozero measures
the spectrum of the solvent. These data are stored for comparison of the spectra of your analytes with the
spectrum of your solvent. Thus, a new scan autozero should be performed each time the solvent is changed.

A scan autozero is performed by pressing the green Auto Zero button for 2 seconds or longer. The autozero
is then measured and calculated over the wavelength range set for scanning.

4.5.3  Performing Wavelength Scans

To acquire scan data:

1. Enter the SCAN menu by pressing the yellow SCAN button once.

2. When pressing the SCAN button a second time, a scan is performed immediately.

3. When taking different scans during a run, be sure to adjust the scan number between scans. Stored
scans are overwritten without any message, when the SCAN button is pressed twice.

4.5.4  Output of Scan Data

The stored scan data can be given out via analog outputs and with defined data rates.

Note that the scan analog output is fixed at 10 AU = 1 V and is not changeable by the user. Use your chart
recorder voltage selection range to scale the output as needed.

Time scaling of the data can be adjusted between 1 and 50 steps per second (approximately 1–50 nm/s) in
the SETUP menu. Low output speed settings lead to enhanced spectral resolution of the data output.

To output scanned data, 

1. Move the cursor with the Right arrow to the OUT field in the scan menu.

2. Press the Up/Down arrows to start the scan output. Make sure that the desired scan number is
chosen. Since every scan is kept in internal storage it can be edited or given out several times.

Scans are deleted by overwriting with new scan data or when the wavelength range is changed.
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4.6  QUADTEC DETECTOR WAKE-UP PROGRAM

Program # 30 is reserved for the Wake-Up function, enabling the lamp to be turned on or to preset a
wavelength program time or date. For example, if the lamp was switched off overnight, the Wake-Up function
can be used to switch on and preheat it the next day. Editing program # 30 will show the following screen:

Figure 4-15. Wake-Up Program

In this window the desired wake-up time, date, and program can be set by means of the numeric keys. Then:

1. On loading the Wake-Up program, the question “Switch lamp OFF? Confirm by cursor” will be
displayed. Pressing any arrow key will then switch the lamp off and start the Wake-Up program. The
activated program is indicated by a blinking Wake-Up screen in the display.

2. As soon as the preset time is reached, the lamp is switched on, the wavelength set according to the
chosen program and an autozero is performed.

4.7  GLP MENU

The GLP report provides the operating statistics of the detector.

Figure 4-16. Block Diagram of the GLP Menu
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4.8  CONNECTING OTHER INSTRUMENTS TO THE QUADTEC DETECTOR

4.8.1  Using the Event and Remote Connectors

Located on the rear of the QuadTec detector are two electrical connectors (Event and Remote) that serve to
send or receive signals from other instruments. The Event and Remote interfaces are controlled by programs
or the SETUP menu.

Figure 4-17. Remote and Event Connections

Event Connectors
1. The QuadTec provides two control outputs. Event 1 (E1) is a relay output and Event 2 (E2) is a TTL

(Transistor-Transistor-Logic) output.
2. All voltages have to be mounted between Ground and the corresponding Event connector.
3. The conditions 0, 1, or 2 are programmed with the numeric keys 0, 1, or 2.
4. The event socket can be used e.g. in combination with a fraction collector connected to the relay

output. The relay will close when the corresponding event E1 is set to 1 in the method and if the
signal level chosen for fraction collection in the Setup menu is exceeded.

Remote Connectors
The remote socket on the rear side of the QuadTec detector serves for sending and receiving start signals or
error signals to or from other instruments. For example, an injection valve or an autosampler giving start
signals can be connected to the Start in input. All voltages must be mounted between Ground and the
corresponding output.

4.8.2  RS-232 Serial Interfaces

The two RS-232 serial interfaces on the rear of the detector enable digital data transfer between the
QuadTec detector and compatible instruments such as the Biologic DuoFlow system.
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5.0  MAINTENANCE

5.1  CHECKING THE STATUS OF THE DEUTERIUM LAMP

The deuterium lamp used with the QuadTec has an extended life time to ensure long-time functionality and
reliable measurements with low noise and baseline drift as well as high sensitivity. The lifetime of the lamp
depends on different factors, like the number of lamp starts, average burning time, and user requirements for
noise and sensitivity.

To check the functionality of the lamp, routinely check the two intensity values “sig” and “ref” found in the
Signal field accessed in the QuadTec Setup menu. The “ref” value refers to the intensity of the light
measured in the reference channel and can be used for checking the quality of the lamp. To check these
values:

1. Replace the flow cell with the dummy flow cell originally shipped with the QuadTec.

2. Wait 10 to 15 minutes for the deuterium lamp to warm up, and then select wavelength 1 = 240,
wavelength 2 = 0.

3. Access the Setup menu Signal field and record the value of “sig” and “ref.”

The expected value with a new deuterium lamp should be in the range of 0.1 to 0.9.

If higher noise levels or decreased sensitivity are observed on working with the QuadTec and these
observations coincide with a ref value of approximately 0.2 or less, a new deuterium lamp should be
installed.
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5.2  CHANGING THE LAMP

1. Let the lamp cool down for at least 15 minutes after switching it off.
Caution: Remove the power plug before opening the QuadTec case.

2. Unscrew the six screws around the base of the detector housing and remove it by lifting.

3. The lamp is located in a black housing on the right side of the instrument. The Deuterium lamp is
shown in Figure 5-1; the Halogen lamp is shown in Figure 5-2.

4. Pull the lamp’s electrical supply cable connector from its socket.

5. Unscrew the two screws in the lamp socket and remove the lamp and connected cables. Insert the
new lamp assuring that it is correctly seated in the guiding slot and screw it in securely.

Caution: Do not touch the lamp glass. Should you touch it accidentally, clean it thoroughly with a
lint free cloth and isopropyl alcohol.

Figure 5-1. Replacing the Deuterium Lamp
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Figure 5-2. Replacing a Halogen Lamp

6. Insert the lamp’s electrical supply cable connector into the appropriate socket. The deuterium lamp
has a three-pole plug, the halogen lamp a two-pole one. It is impossible to plug a lamp’s power
supply into the wrong socket.

7. Put the lid back on from the top of the instrument and fasten the screws of the cover.

8. Install the dummy cell, set the wavelength to 240 nm, and record the signal and reference values as
a reference to track the lamp output and flow cell cleanliness.

9. If you are not changing the lamp type (i.e. you replaced a deuterium lamp with a new deuterium
lamp or a halogen lamp with a new halogen lamp), then the QuadTec Setup menu remains
unchanged, but the lamp working hours should be reset (see page 4-3).

If you changed lamp types (i.e., from deuterium to halogen or halogen to deuterium), follow the
procedure below.

Changing Between Lamp Types

If you changed lamp types (i.e., from deuterium to halogen or halogen to deuterium), then the QuadTec
Setup menu must be modified to reflect the change in lamp type.

1. Turn on the detector and when the screen displays the firmware version (e.g. v1.5), immediately
press the green arrow keys in the following sequence: Up/Down/Up. This loads the Extended Setup
application.

2. After initialization and calibration are complete, select the Setup menu by pressing the right green
arrow key until the cursor is blinking next to Setup on right side of LCD. Hold the arrow key for a few
seconds and the Extended Setup menu will appear.
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3. From the Extended Setup menu, press the Down arrow to access the desired menu items. Make the
following modifications:

a. LAMP: The lamp type is specified using the Up arrow to toggle between deuterium and
halogen.

Changing the lamp type prompts a question on whether to reset the lamps’ working time.
Pressing any green arrow key will reset the time. The lamp number is incremented automatically
and cannot be edited.

When replacing a deuterium lamp, the working time should be reset as this value is used in the
GLP report. Position the cursor on the working time value and press the Up arrow. Pressing the
Up arrow again resets the working time to zero and increments the lamp number.

b. WAVELENGTH: For a halogen lamp, set filter to 999 nm and set Range to 300–900 nm.

For a deuterium lamp, set Filter to 380 nm and set Range to 190–740 nm.

4. Exit the Extended Setup menu by pressing the left arrow key to return to the Main menu. Power off
the QuadTec and then turn the detector power back on.

5.3  CLEANING THE FLOW CELL

Noisy baselines and low sensitivities may be due to a dirty flow cell. This may also be indicated by a low
value for “sig” in the Signal menu. A high ref value but low sig value indicates the lamp output is good but the
flow cell is probably dirty. The flow cell should be rinsed with the following solutions, allowing each solution to
be in the flow cell for 2–3 minutes. Inject the solution directly into the flow cell; do not run it through your
automated system.

1. Rinse with at least 10 ml of deionized water to remove salts.

2. Rinse with several ml of 100% analytical grade methanol to remove lipid contamination.

3. Rinse with at least 10 ml of deionized water.

4. Rinse with 1 M NaOH to digest proteins.

5. Rinse with at least 10 ml of deionized water.

6. Rinse with 50% acetic acid.

7. Rinse with at least 10 ml of deionized water.
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6.0  TROUBLESHOOTING

Problem Possible Cause Suggested Solutions

QuadTec detector Communications
faceplate does not problem between the
show up in BioLogic QuadTec Instrument
DuoFlow software Control Module and the
Manual screen. DuoFlow Controller 

software

QuadTec detector Deuterium lamp output 
fails to complete is low.
wavelength 
calibration routine 
or calibration takes 
an excessively 
long time.

Wavelengths Software options
chosen in the are not configured 
Manual screen appropriately.
detector control 
panel do not show
up on the Manual 
screen 
chromatogram.

Wavelengths chosen Normal ocurrence
in the Manual screen 
are not automatically 
copied to the Setup 
editor.
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1. In the DuoFlow Manual screen, click on the
detector faceplate toggle button to switch between
QuadTec and optics module faceplates.

2. Ensure that the power cable from the ICM to the
back of the DuoFlow Workstation DC outlet is
connected.

3. Ensure that both the Workstation and QuadTec
Detector are switched on and that System Cable
25 (RS232), System Cable 26 (QuadTec Power)
and System Cable 17 (BioLogic Communication)
are correctly connected.

If these steps do not resolve the problem:
1. Exit the BioLogic software application to the

Windows desktop;
2. Turn the Workstation power off and then on.

Repeat for the QuadTec;
3. Allow a few minutes for the QuadTec to initialize,

self-test and calibrate. The bottom left corner of the
detector screen must show ON before the
DuoFlow software is launched.

4. Launch the BioLogic DuoFlow software application.

Replace deuterium lamp.

1. Ensure that the Set button is clicked.
2. Click on the Manual screen Settings icon to

choose which traces are visible.
3. Zero the baseline.

1. The Manual screen and Setup Editor are not
linked. You must select the desired wavelengths for
each Method.



Problem Possible Cause Suggested Solutions

Wavelengths chosen Software options are  
in the Setup editor not configured 
detector devices box appropriately.
do not show up on
the Run screen 
chromatogram.

No traces are seen Software options are 
on the Manual not configured 
screen or Run appropriately,
screen or lamp output is low.
chromatogram.

With the BioLogic HR BioLogic HR software 
software, no traces options and QuadTec 
are seen in either the Setup menu may not be 
Manual screen or configured appropriately.
Run screen 
chromatograms.

UV baseline is noisy  Lamp output is low,
or unstable. or the flow cell is dirty.

UV baseline shows Air bubbles trapped in 
a “zig-zag” or saw- the flow cell is a very 
tooth trace. common cause.
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1. Click on the Run screen Settings button to choose
which traces are visible.

2. Zero the baseline as appropriate.
3. Re-scale the chromatogram traces using the scroll

bars as appropriate.

1. Ensure the correct lamp is installed and that the
lamp is turned on both in the BioLogic Manual
screen QuadTec control panel and in the QuadTec
detector setup menu.

2. Check on the lamp status using the QuadTec
setector setup menu. Replace the lamp if
necessary and ensure the correct Setup
configuration is chosen (see Maintenance chapter).

3. Zero baseline and adjust scales as appropriate.

1. Ensure that the QuadTec detector and lamp are
turned on (hardware and software).

2. Carefully follow the instructions in chapter 3 to
ensure that the analog outputs from the QuadTec
to the SIM-HRs are correct.

3. Ensure that the SIM-HRs are configured correctly
both in the HR software and the QuadTec Setup
menu with regard to voltage input and ranges (see
chapter 3).

4. Ensure that the correct wavelengths are chosen on
the QuadTec faceplate.

5. Check on the Manual screen and Run screen
Settings editor to ensure that the desired traces
are active.

6. Zero the detector from the QuadTec faceplate

1. Check the lamp status as described in the
Maintenance chapter. Replace if necessary.

2. If lamp is OK, clean the flow cell using the
procedure detailed in the Maintenance chapter.

1. Always degas buffers.
2. Inject a few ml of methanol into the flow cell to

clear the bubble.
3. Connect a 40 psi back-pressure device after the

flow cell to prevent outgassing.



Problem Possible Cause Suggested Solutions

Excessive pump Air bubbles trapped in 
pulsations exhibited the pump heads can 
as a sinusoidal produce exaggerated 
baseline or “regular pulsation, which appear
noise” on the  as a noisy baseline.
detector baseline.

Lamp test Lamp needs 
performed from burning in.
QuadTec Setup  
Signal menu gives
error message 
“E INT”.

Baseline noise Noise spikes can also 
continues when be caused by external 
pumps are environmental influences.
turned off.

UV trace will not If no air bubbles are 
zero. present in the flow cell, 

check that the cell itself 
is clean both internally
and externally.

Drifting baseline. Non-homogeneous 
solvent due to poor
mixing or flow rate
variation.

Slow column 
equilibration.

If drift is due to a higher 
absorbance, suspect that
UV absorbing material
may be leaching from the
column.
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1. Purge the pump heads to remove trapped air
bubbles. See the Troubleshooting section of the
BioLogic DuoFlow instruction manual.

1. Leave the lamp burning for several hours (up to
24).

2. Retest periodically from the Setup menu.
3. If error message persists, contact Bio-Rad

Technical service at 1-800-4-BIORAD.

1. If the spikes occur at regular intervals (for example,
once every 20–30 sec), check for the presence of
heating baths, drying ovens, or other heating
devices on the same electrical circuit or in close
proximity to the BioLogic DuoFlow system. Turn off
these devices to see if the problem goes away.

1. Clean the interior of the flow cell using the
procedure outlined in the Maintenance chapter.

2. Condensation may occur on the exterior windows
of the flow cell when moving the optics unit from
the lab to a cold room and vice versa. Always allow
an equilibration period to compensate for such
temperature effects.

1. Check flow rates of both pumps; recalibrate if
needed by selecting Calibrate Gradient Pump from
the Utilities drop-down menu.

2. Some ion exchangers are slow to equilibrate
especially if just sanitized. Allow a longer
equilibration period.

3. To confirm this, remove the column and run DI
water or an aqueous non-absorbing buffer. If the
baseline is stable, then the column is suspect.
Consult the column’s user manual for cleaning
procedures.



Problem Possible Cause Suggested Solutions

Negative peaks. The sample is applied to
the column in a different
buffer from that used to
equilibrate and elute the
column. Refractive index
changes may be
responsible for the
negative peaks.

The elution buffer may
have a higher UV
absorbance than the
sample components.

False or ghost The injection valve, 
peaks. injection port, and loop

were not rinsed out
between sample
injections.

Strongly-retained sample
components may still be
eluting from a previous
run.
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1. Apply the sample in the same buffer used to
equilibrate the column.

2. Check the elution buffer’s UV absorbance.

1. Rinse valve, port, and loop with buffer. For
example, if the sample loop contains 100 µl, then
program a load/inject volume of 200 µl to
completely flush the valve and loop.

2. Always clean large volume dynamic loops, such as
the Bio-Rad DynaLoop™, between use to avoid
cross contamination.

3. Use stringent elution conditions or consult the
column’s user manual for an appropriate wash
step to remove such components between runs.



APPENDIX A
SPECIFICATIONS

Lamp type Deuterium (standard)
Halogen (option)
User-replaceable

Wavelength range 190–740 nm with deuterium lamp, automatic edge filter used at 380 nm
370–740 nm with halogen lamp

No. of simultaneous 4 with Biologic DuoFlow system
wavelengths 2 with Biologic HR system

2 in stand-alone mode

Bandwidth 8 nm

Wavelength accuracy 1 nm

Measurement range 0–4 AU

Sensitivity 2 x 10-5 AU at 240 nm and time constant 1.0 s

Noise 1: 1 x 10-5 AU at 240 nm, 1.0 s
2: 2 x 10-5 AU at 240/300 nm, 1.0 s

Baseline drift 1: 10 x 10-5 AU/hr at 240 nm, 1.0 s
2: 15 x 10-5 AU/hr at 240/300 nm, 1.0 s

Linearity 2% deviation up to 2.0 AU at 254 nm with acetone

Time constants 0.1/0.2/0.5/1.0/2.0/5.0/10.0 s

Auto zero range Full scale

Weight 5.5 kg (15 lbs)

Dimensions 160 x 185 x 340 mm (W x H x D), (6.3 x 7.3 x 13.4 in)

Qualification (GLP) Records total operating hours, lamp changes, lamp ignitions
support

Flow cell PEEK, 3 mm pathlength, 2 µL volume
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APPENDIX B
WAVELENGTH SELECTION FOR TYPICAL BIOLOGICAL MOLECULES

Wave-
length Absorbing Species Applications

206 nm Carboxyl groups, Proteins, peptides, 
ester links, amide or amino acids, 
peptide bonds steroids,

nucleotides,
fatty acids,
carbohydrates 

214 nm Peptide bonds Peptides, proteins

224 nm Peptide bonds Peptides, proteins

245 nm Peptide bonds Proteins in the
presence of Triton
X-100

254 nm Nucleotides Nucleotide bases,
260 nm DNA, RNA

280 nm Aromatic amino acids Proteins

313 nm Conjugated ring Certain vitamins, 
systems antibiotics

365 nm Conjugated ring Some steroids, 
systems NADH,NADPH,

flavoproteins,
bacteriochlorophylls

405 nm Heme group Myoglobin

550 nm Cytochromes

WAVELENGTH SELECTION APPENDIX B
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Comments

Virtually all biological macromolecules will absorb
at this wavelength. Detection at this wavelength
will give high sensitivity and/or permit the
detection of compounds that don’t absorb at other
wavelengths. Some buffers cause a problem with
background absorbance.

This wavelength allows one to use many of the
buffers that might give problems at 206 nm and
yet yields much more sensitivity than 280 nm.

This wavelength detects any compound with
peptide bonds. It is less sensitive than lower
wavelengths but more sensitive than 280 nm; It is
used to overcome the interferences seen with
many buffers at 206 nm.

Triton X-100 absorbs strongly at 280 nm and may
mask true protein absorbance at that wavelength.

These are the best wavelengths for nucleic acids.

This is the traditional wavelength for protein
detection and therefore the most frequently used
by the biochemist. As aromatic amino acids
absorb best at this wavelength (i.e. tryptophan,
tyrosine, and phenylalanine), proteins with few of
these amino acids may not absorb as strongly as
expected.

Flavoproteins exhibit absorption maxima at 280 nm,
350–380nm and 450 nm. Reduction of the flavin
eliminates the absorption at 450 nm.

Reduced cytochrome c absorbs at 550 nm.





APPENDIX C
ORDERING INFORMATION. SPARE PARTS AND ACCESSORIES

760-1300 QuadTec DuoFlow Detector Kit; 100/110 V; 200/240 V

Includes QuadTec Detector, 3 mm flowcell, System Cable 25 RS232 null modem cable, 4 x 10-32
Fingertight fittings and QuadTec Accessory kit for the DuoFlow. This accessory kit includes
Instrument Control Module (ICM), System Cable 26 ICM power cable, System Cable 17
BioLogic communication cable, DuoFlow software version 3.0, DuoFlow Instruction Manual
chapter inserts, QuadTec Instruction Manual, and US power cord

750-1310 QuadTec BioLogic HR Accessory Kit 

Includes 1 x Cable 17 BioLogic communication cable, 2 x SIM-HR, 2 x System Cable 24 Analog
out cables (QuadTec to SIM-HR), QuadTec Instruction Manual, US power cord

760-1330 Deuterium lamp

760-1331 Halogen lamp and holder; holder needed for first time use

760-1332 Halogen lamp

760-1306 Flow cell, PEEK 3 mm path length

760-1311 Long fingertight fittings, 10-32 x 1.03”, 4

760-1321 System Cable 26, Instrument Control Module power cable

Connects ICM to power outlet on rear of DuoFlow Workstation

750-1307 System Cable 25 QuadTec RS232 null modem cable

Connects QuadTec to the ICM

760-1309 System Cable 24 QuadTec Analog-to-bare wire cables (quantity, 2)

Connects QuadTec to two SIM-HRs for use with the BioLogic HR system

750-0650 System Cable 17, BioLogic Communication Bus cable

Connects devices and instruments to the BioLogic system

760-1301 QuadTec Instruction Manual

760-0003 DuoFlow software version 3.0

Includes CD and chapter inserts for the DuoFlow Instruction Manual

Tefzel is trademark of E.I. de Pont de Nemours and Co.
PEEK is a trademark of Victrex PLC.
Triton is a trademark of Union Carbide.
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